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Managing data with tables

The advantages of an Excel table include all of the following:

1.

1)
2)
3)

4)

9)

6)

= Is - o . =
I:l? EI 1. Click on the EE Get Add-ins E I'?
PivotTable Rec_ommended Table  Pictures inlne Insert tab - & vy Add-ins ~ Bing People Recommende
PivotTable Pictures Maps Graph Charts
lllustrations Add-ins

2. Click on the
Table command
button

Quick Styles

Add color, banded rows, and header styles with just one click to style your data.

Table Names

Give a table a name to make it easier to reference in other formulas.

Cleaner Formulas

Excel Formulas are much easier to read and write when working in tables.

Auto Expand

Add a new row or column to your data, and the Excel table automatically updates to include the new
cells.

Filters & Subtotals

Automatically add filter buttons and subtotals that adapt as you filter your data.

Dynamic Pivot tables

If you use an Excel Table for the source data of your pivot table, the data range becomes "dynamic".
A dynamic range will automatically expand and shrink the table as you add or remove data, so won't
have to worry that the pivot table is missing the latest data. When you use a Table for your pivot
table, the pivot table will always be in sync with your data.

Make your data into a table

Page Layout Formulas Data Review View Help Q Tell me what you want to do

Table (Ctrl+T)

Create a table to organize and
analyze related data.

Where is the data for your table?
=SAS1:5N552|

|

3. Awindow will open.
Confirm the cells to be
included in the table and that

Cancel the data has headers

My table has headers

Sallf
4

LA

| Tables make it easy to sort, filter, D E F G
1 |Name Y and format data within a sheet. genow Date registered Age at registration Instrument experience
2 |Alain Prost © Tell me more 05,/04/2003 Guitar
3 |Alia Bhatt rrrer—rrorrorerary S 09/09/2016
4 |Andre Agassi HMP Swansea 14/12/1975 21/03/2003 Guitar
Create Table ? *



2. Naming the table

It is good practice to name the table as it makes life much easier later when working with formulas. Naming
the formula is basically giving your data set a name which will enable you to recognise which data set you
need to be working with.

Music Mentors data with notes - Excel

Home Insert Page Layout Formulas Data Review View Help Design

oble Neme: | 3] Surmmarize ith Pivtable = Uresterron rconmn 1. Click on the table & select
S =
Irablez I8 Remove Duplicates [[] Total Row [[] Last Column . -
insert | Export Refresh Banded Rows [ ] Banded Columns the DeSIgn tab -

£ Resize Table Slicer = °

Properties External Table Data Table Style Options Ay

B5

2. Rename the table. For
example, “Participants”

SEEE

3. Formatting the table

There are a number of table formatting options in Excel. The benefit of the table format is that it ensures
each new column or row you add to your table will be automatically formatted in the same way.

Tab Music Mentors data with notes - Excel
File Home Insert Page Layout Formulas Data Review View Help @ Tell me what you want to do

[able Mame: Summarize with PivotTable D Header Row  [] First Column Filter Button

[rable2 - Remove Duplicates N LTT — [] Total Row [ tast Column

N nse port Refres

£ Resize Table % Convert to Range Slicer - - Earceilionglleandcdiecin e
Praperties Tools External Table Data Table Style Options

B5 < Jx | HMP Manchester

n Prison n Date of birth n Date registered - Instrument experiencen Total hoursn Points per hour kg

i

2 |Alain Prost HMP Manchester 14/06/1960 05/04/2003 Guitar 10 3
3 |AliaBhatt HMP Holloway 05/09/1964 09/09/2016 23 1]
4 |andre Agassi HMP Swansea 14/12/1975 21/03/2003 Guitar 29 2

Change the look and feel of
your table with the formatting
tools




4.

Adding a Total column

qll

- Saved

O Search

Alice Linell | {4

File ~ Home Insert Pagelayout Formulas Data Review View Help Table Design 2 Share 7 Comments
—
- aA v | = | . [ conditional Formatting v = BB Insert ~ v 4V NS
D & Calibri 11 VAN T = v a, General 9 2 v ‘ [
o B ¥ - % 9 BEFormal sum (Alt+=) 3 sum =
EE BIUvYHvOvA.W =E=E=E E - . . t
. Moy A === == <0 .00 57 cell sty Agtomatlcally add it up. Your total Average .
will appear after the selected cells.
Clipboard s Font [ Alignment IS Number M . Count Numbers sitivity ~
c2 - K| 3 Max =
A B C D £ F G H | | [ . P -
Date |l MM Supervisor B HMP Holloway [l HMP Bristollll HMP Pentonville [l HMP Bronzefield [l HMP Manchesterlll HMP Swansea|lll Total mentors [ Min
1an-17 Amina Hussain
Feb-17 Amina Hussain More Eunctions...

Mar-17 Amina Hussain
Mar-17 Amina Hussain

© @~ E e W

4 1 5
4 3 7
3 1 5
Apr-17 Amina Hussain 5 4 3 5
May-17 Asif Kahn 4 4 2 6
Jun-17 Asif Kahn 4 4 1 5
Jul-17 Asif Kahn 4 5 2 7
4 4 1 5
4 6 3 4
1. Highlight the cells you want : 2 : :
. . 4 4 1 5 2.
totalled, including the blank . s 2 ; On the Home tab, click on
. 4 4 1 5 Sum

cell where the total will go : : : :
4 4 1 5
T - - 4 6 5 4
21 Jul-18 Rachel Rossi 3 4 4 4 1 5
22 Aug-18 Rachel Rossi 4 13 3 3 4 6
23 Sep-18 Rick Wilmot 3 7 5 3 3 7
24 Oct-18 Rick Wilmot 4 13 13 7 2 6

28 Mo 12 Michael Rocanhars A I S 2 a -

Participants | Mentors | Service feedback | Aftendance | Outcomes | Supervisors | Useful formulas | (3 HE] »
Ready Average: 383333333 Count 6 Sum:23 L@Displaysetings | FH LI 1 + 100%

5.

Adding a Row Total

Autosave D 2

Test Attendee data for Excel Bitesize 1 - Managing your data with Excel £ Saving... ¥

0

File'  Home |Insert Pagelayout Formulas Data Review View Help Table Design
—
Table Name: Summarize with PivotTable E? @ [5‘3 Properties Header Row | _|First Column Filte
=X %
. L . 4
Table3 @ Remove Duplicates Insert | Exoort R fKJh ?@Open in Browser ¥ Totgf Row L Last Column
- i o) n_se xport hetresh -~ | ) Baffled Rows [ | Banded Columns
‘B Resize Table | &z Convert to Range Slicer v v S Unlink
Properties Tools External Table Data Table Style Options
5 Mar-17 Amina Hussain https://superhighw 8 8 5 12 5 20
6 Apr-17 Amina https://superhighw:
7 May-17 Asif Kahn https://superhighw: 10 10 13 4 18
8 Jun-17 Asif Kahn https://superhighw:
i) Jul-17 Asif Kahn https://superhj 8 8 2 1, 2 20
0 Ay”™
K | o 7 2 4 13
2 4 1. Highlight the columns you
3 N 7 3
| want totalled .
5| 1 o o 2. On the Table Design tab,
sl A — : check the box Total Row
7 Mar-18 Kathleen O'Leary |https://superhighw. 7 6 11
8 Apr-18 Kathleen O'Leary |https://superhighw:
9| May-18 Rachel Rossi https://superhighw: 7 7 12 11 4 13
PO Jun-18 Rachel Rossi https://superhighw:
P1 Jul-18 Rachel Rossi https://superhighw: 6 8 5 12 5 17
22 Aug-18 Rachel Rossi https://superhighw:
P3 Sep-18 Rick Wilmot https://superhighw: 8 7 11 38 6 19
P4 Oct-18 Rick Wilmot https://superhighw:
P5 Nov-18 Michael Rosenbery htips://superhighw: 8 7 7 9 4 13
PG Dec-18 Michael bery https://superhighw:
p7 Jan-19 Michael Rosenber( httos://superhighw: 7 9 B 15 o 14
) Feb-19 Michael R ber https://superhighw:
P9 Mar-19 Matthew Miller | htips://superhighw: 7 5 3 12 6 11
BO Apr-19 Matthew Miller | htips://superhighw:
B1 May-19 Matthew Miller  |https://superhighw: 6 7 10 16 6 10
R ! 10 RA 128 LV HIP bt L, 1 rhish:




Filtering

6. Filtering (Select & Deselect)

AutoSave Music Mentors data with notesxlsx & - Saved /O Search

File Home Insert Page Layo| i Fign
1. Click on the arrow next to the column
11 - S header of the column you want to filter by
B I
1 Prison
2 2] sotAtoz | 14/06/1960 05/04/2003 Guitar 10
3 05/09/1964 09/09/2016 23
Z) sort7zton I ;

4 A S0 | 14/12/1975 21/03/2003 Guitar 29
5 Sort by Color > 08/08/1998 09/09/2016 12
6 _ 09/06/1972 27/02/2017 Trumpet 7
7 §% _ 14/04/1957 21/03/2008 30
8 > | 08/09/1956 17/08/1998 Piano, trumpet 25
9 et Filters 5 | 19/06/1971 31/01/2008 Piano 19
1 29/06/1961 21/03/2003 2
1° Search 28
1 ¥ (Select All) 2. Select the values you want to filter by 3
15 HMP Bristol 3
12 HMP Bronzefield | 28/06/1969 17/08/1998 31
1t HMP Holloway | 09/09/1984 19/02/2004 9
16 HMP Manchester _ 18/05/1961 17/08/1998 Guitar, Piano 22
1 HMP Pentonville | 04/04/1979 30/09/1999 18
1¢ HMP Swansea | 04/04/1979 30/09/1999 18

T { D

56_ When you have applied the filter, look at the bottom of the

57— sheet to see the total count of the filtered rows.

J
| — T

Particpants M | Outcomes | (¥

Ready 20 of 51 records found




7.

Filtering (Text filters)

Excel has more advanced filtering options available via text filters:

iWoIfgang Pud
Julie Walters

~ Usain Bolt
Alain Prost
A
Ha

1
2

3

4 Margaret Atwoo
5

6

7 Custom AutoFilter
8

;| Show rows where:

lPrison
HMP Pentonville
HMP Bronzefield
HMP Bronzefield
HMP Manchester
HMP Manchester

4. Check the

N\
Music Mentors data with notes.xdsx && - Saved ,O Search 1 CIICk on the arrow next to
the column header of the
File Home Insert Page Layout Formulas Data Review View Help Table De: .
column you want to filter by
B2 - fe | HMP Pentonville J
A B C E G | L
Ll Name B Prison [ Date of birth |l Date registered
2 |Wolfgang Puck HMP Pentonville ) 11/10/1982 gl SortAto Z | 1 1
3 Julie Walters HMP Bronzefield 20/09/1973 5 | 9 2
4 Margaret Atwood  HMP Bronzefield 18/09/1963 Al sotzton 7 8 2
5 Usain Bolt HMP Manchester 21/07/1994 Sort by Color > 34 3
6 Alain Prost HMP Manchester 14/06/1960 10 3
7 |Andre Agassi ? | 29 2
8 |Harper Lee 2. Select Text Filters > | 2 2
9 Hone Heke Text Filters > Equals.. 1
10 Jason Robinson - 2
11 Lionel Ritchie HMP Bristol 08/12/1968 Search A Does Not Equal... 1
12 Lorna Williamson HMP Holloway 10/04/1948 [v] (Select All) A~ 1
13 |Serena Williams HMP Holloway 31/01/1981 Bass Begins With... 1
14 John Steinbeck HMP Pentonville 16/02/1965 Bass, guitar Ends With... 1
15 John Steinbeck HMP Pentonville 16/02/1965 Drums 1
16 |Enid Blyton HMP Bronzefield 18/05/1961 v] Guitar Contains... 2
17 Marcus Clarke HMP Bristol 16/02/1970 vl Guitar, bass Does Not Contain.. 1
18 David Beckham HMP Pentonville 19/06/1971 ¥ Guitar, Piano 1
19 Max Senski HMP Swansea 08/03/1980 {/Keyboard Custom Filter... 2
b0 Jane Goodall HMP Holloway 03/02/1951 {¥IPiano i 36 1
P1 Jane Goodall HMP Holloway 03/02/1951 36 1
b> David Attenborough  HMP Bristol 08/09/1956 T szl 25 1
P3 Jack Tate HMP Manchester 14/10/1949 Yo u suus saAupTIUITG 12 3
Music Mentors data with not
File wlas Data Review View Help
3. A Custom AutoFilter
P15 . .
window will open.
C E G H |

filter type Drums 34
e o uitar 108
? X

9 Hg .
— Instrument experience
10 _Ja_
11 I Lid contains ~ | drums
12_ Lg ®and Oor
13 Se ~
14 JC_I
15 Jg Use ? to represent any single character

5. Enter the value .
you want to filter by B

16 En Use * to represent any series of characters

17 M

18 D4 Cancel | |F
1Q_M_:v Sencki HMP Swansea 0R/02/1980 09/09/2016 Piann 7 r




8. Data Slicers

Slicers are visual filters. Using a slicer, you can filter your data (or pivot table or pivot chart) by clicking on the

type of data you want.

1. Click on the

AutoSave B 9~ Insert tab ixisx &£ - Saved . -
2. Click on
File Home Ins_er‘t Page Layout Cview View Help Slicer :
lﬁ_?-r; E "_('3 Ej"Get Add-ins I:h'? ED] v I:E" \, - Es.hcer.
d i PO‘ v [ﬂ]] v [‘E', - = =i R4 T Column B Timeline
PivotTable Recommended lllustrations ,/J i Al E Recommended 4 R Maps PivotChart 3D )
PivotTables v L ns Charts Q- - v > Map ~ J'E Win/Loss
Tables Add-ins Charts Nl Tours Sparklines Filters
A B C B G H | L
1
2 Wolfgang Puck HMP Pentonville 11/10/1982 20/01/2002 Bass 1
3 |Julie Walters HMP Bronzefield 20/09/1973 08/02/2012 Bass, guitar 9 2
4 |Margaret Atwood HMP Bronzefield 18/09/1963 07/06/2015 Drums 8 2
5 lUsain Rolt HMP Manchester 21/07/1994 05/05/2014 Drums 34 3

File Home Insert Page Layout Formulas Data Review View Help T4

Al - I Name
A B C E G

1 .
2 1. Insert Slicer 11/10/1982 20/01/2002 Bass

N window will open. -
3 5s, guitar

y ~| Insert Slicers ? X
4 | 1 ams
5 U 1 ams
6 A| 2.Selectthe Manchester = | DN&_‘me jtar
7 Al column(s) you would [IPrison tar

"4l like to use for [Jate of birth b
8 [H Ca tar

l | g now | R
9 Pentonville DDgt tored tar

m B dle registere |
10 Jason Robinson HMP Swansea | [Tageat rgegistration itar
11 Lionel Ritchie HMP Bristol A | [Jinstrument experience itar
12 Lorna Williamson HMP Holloway | Trotal hours itar
13 |Serena Williams HMP Holloway . tar

| - - | | []Points per hour o
14 John Steinbeck HMP Pentonville A | [Trotal points itar, bass

Nty




AutoSave @ El:"

File Home I

Prison -

| Wolfgang Puck
Julie Walters
|Margaret Atwood
' Usain Bolt

_|Alain Prost
|Andre Agassi
Harper Lee

Hone Heke

® N AW 2

©

'IOiJason Robinson
11 |Lionel Ritchie

12 |Lorna Williamson
13 Serena Williams
14 John Steinbeck
15 John Steinbeck

%] Music Mentors data with notesxlsx &8 - Saving... ,O Search Alice Linell s B
nsert Page Layout Formulas Data Review View Help Slicer 1 Share
S
B C . L M N o
-Prison -Dateofbirth -Date re 3' Drag and drop the Sllcerto o
HMP Pentonville 11/10/1982 the |Ocati0n you wa nt 1 Prison = V7
HMP Bronzefield 20/09/1973 2
HMP Bronzefield 18/09/1963 2 i HMP Bristol l
HMP Manchester 21/07/1994 05/05/2014 Drums 3 i HMP Bronzefield l
HMP Manchester 14/06/1960 05/04/2003 Guitar 3
HMP Swansea 14/12/1975 21/03/2003 Guitar 29 2 i HMP Holloway l
HMP Bronzefield 07/09/1949 04/04/2009 Guitar 23 )l HMP Manchester l S
HMP Pentonville 27/04/1983 09/09/2016 Guitar 6 1
HMP Swansea 02/02/1950 04/05/1999 Guitar 11 2 i HMP Pentonville l
HMP Bristol 08/12/1968 27/04/2007 Guitar 26 1 [ HMP Swansea ]
HMP Holloway 10/04/1948 19/02/2004 Guitar 15 1
HMP Holloway 31/01/1981 24/11/2005 Guitar 14 1
HMP Pentonville 16/02/1965 21/03/2003 Guitar, bass 6 1
HMP Pentonville 16/02/1965 21/03/2003 Guitar, bass 6 1 O O o)

AutoSave sic Mentors data with notesxlsx a8 - Saved P Search
File Home Insert Page Layout Formulas Data Review View Help 122 Sharq
P27 - I
A B C E G H | L M N o
- Prison H Date of birth - Date registered
5 :Usain Bolt HMP Manchester 21/07/1994 05/05/2014 Drums 34 3 Prison = 2
6 |Alain Prost HMP Manchester 14/06/1960 05/04/2003 Guitar 10 3
23 |Jack Tate HMP Manchester 14/10/1949 05/04/2003 Saxophone 12 3 HMP Bristol
27 |Raj Kapoor HMP Manchester 27/01/1997 25/05/2015 Violin, Guitar 7 3 HMP Bronzefield
29: Ben Okri HMP Manchester 08/08/1998 09/09/2016 12 3]
46 Robert Hall HMP Manchester i i ~ 5 3 HMP Holloway
47 |Roger Federer HMP Manchester dh HMP Manchester
50 Steven Yeun HMP Manchester 4. Select a single filter
51 Tim Marks HMP Manchester . . 24 3 HMP Pentonville
53 option to apply the filter l HMP Swamsen
54
55
56
57

File Home Insert Page Layout Formulas Data Review SableDesign 12 Shard

A3 . Je || Julie Walters 5. To add more than one
A 8 < filter click on the Multi-

Ll Name M prison Date of birth [l Date reg
3 [Julie Walters |HMP Bronzefield 20/09/1973 Select button
4 Margaret Atwood HMP Bronzefield 18/09/1963 [4)
8 Harper Lee HMP Bronzefield 07/09/1949 04/04/2009 Guitar 23 2 HMP Bristol
12: Lorna Williamson HMP Holloway 10/04/1948 19/02/2004 Guitar 15 i HMP Bronzefield l
13 Serena Williams HMP Holloway 31/01 6l 244100008 Guitas
6 Enid Blyton HMP Bronzefield 18/ 2 l HMP Holloway l
PO |Jane Goodall HMP Holloway 03/ 6. Select multlple fllter 1 HMP Manchester
P1 Jane Goodall HMP Holloway 03/ . 1 -
ZS;Jacina Ardern HMP Bronzefield 12/4 Optlons to app|y 2 HMP Pentonville
P8 Alia Bhatt HMP Holloway 05/ 1 HMP Swansea
B1 Diane Kruger HMP Bronzefield 29/06/1901 170372003 2 2
35: Emma Barnett HMP Bronzefield 28/06/1969 17/08/1998 31 2
37i Fiona Bruce HMP Holloway 04/04/1979 30/09/1999 18 1
B8 Fiona Bruce HMP Holloway 04/04/1979 30/09/1999 18 1
B9 Freya Crew HMP Bronzefield 13/08/1967 04/05/1999 5 2

= Music Mentors data with notesxlsx & - Saved PO search Alice Linell AL =B




Conditional formatting

9. Highlight Cell Rules

The Highlight Cells Rules gives you lots of options for formatting your spreadsheet contents e.g. text colour,

cell background fill colour etc, based on the values in the cells.

AutoSave D B Y-

,O Search (Alt+Q)

Kate White {# '

File Home Insert Page Layout Formulas Data Review View Help Acrobat v
& i v LA == o ab . Hinsert ~ > o~ E ™
pﬁ:] L_B . Poppins 11 A A _E T =] General . % | @? iE}f T Delete o Szi F.Cd)& A
aste = = = &= 5= o = -0 .00 onditional ormat as el — Ol N nalyz
oy Ty~ gl === BB % 9 %W Formatting ¥| Tablev Styles v fEFormaty | €~ Fifter v Select~ Data
Clipboard [ Font = Alignment = Number I Analysi
- >
11 - Jr | Total attendance Highlight Cells Rules Greater Than...
A B (o D E Top/Bottom Rules > Less Than... J
1 |Date MM Supervisor HMP Hollowa'HMP Bristol HMP Pentonv HMP | cel
2 Jan-17 Amina Hussain 8 7 6 ? @ Between... 57|
3 Feb-17 Amina Hussain ﬁ S E:H i7
Color Scall Equal To...
4 Mar-17 Amina Hussain clorseates El==e 8
— A 1 L 1,
5 Mar-17 EEE lcon Sets > EIEHI Text that Contains... &
6 Apr-1 F | lect L th n 2
or example, seiect Less than i
7 MGY'I p ! 10 ﬂ New Rule.. E% A Date Occurring... i4
8 Jun-1 E? Clear Rules > 5
2l Jul-17 Asif Kahn 8 [ Manage Rules.. @ Duplicate Values... 5]
10 Aug-17 Asif Kahn 8 6 10 5 More Rules.. }6
A B C D E F G H |
1 |Date MM Supervisor HMP Hollowa' HMP Bristol HMP Pentonv HMP Bronzefl(HMP ManclHMP Swansed |Total attendance
2 Jan-17 Amina Hussain 8 7 6 10 7 19 5
3 Feb-17 Amina Hussain 7 8 5 12 5 20 57
4 Mar-17 Amina Hussain 8 8 5 12 5 20 58
5 Mar-17 Amina Hussaln 8 Less Than ? X 58
6 Apr-17 Amina Hussadin 7 Format cells that are LESS THAN: 5 62
7 May-17 Asif Kahn 9 4g 4| with |Light Red Fill with Dark Red Text |~ | B 64
5 ——lun=17 Aclf Kahn 3 55
51
Then add a value and choose
) . 6 5 10 5 12 486
what colour you’d like cells to - 2 ]3/ o
be highlighted, where 8 4 Here cells with 46
i i i 7 3 17 47
contents satisfy your criteria values under 48 are
n highlich d . d 18 64
o TOTrToTeeT ‘ 8 9 ighlighted in re 19 62
| Attendance | Participants ‘ Mentors ‘ Topic 1 exercise ‘ TopicZexer\ : : : 1@ 4

10



10. Identifying duplicates

Use the Highlight duplicates function in Conditional formatting to identify duplicates

Home Insert Page Layo
D Lix’ Calibri T i ClICk C.0nd|t|0na| [=] Conditional Formatting ¥ Hinsert ~ >~ 5? O g
B~ ormattlng
g B I U-~ & E Highlig Rules & Greater Than... i Lit=8
Clipboard [E Font K] Alignment 5] Number 5] Ideas
5 c b : T fttom Rules  ~ Less Than... L
1 ame M . M Date of b - M D gistered Iv
P |Wolf| HMP Pentonville 11/10/1982 20, Data Bars > @ Between... 1
B 2 2
. . 1 i 2
1. Highlight the L 3. Click on the arrow next to ales > I, eauatTo.. 2
column you want to 14 Highlight Cells Rules 3
. 143 41 > % Text that Contains... 2
search for duplicates 07/09/1949 s T
27/04/1983 09/09/2lj [ New Rule... gﬂ . 1
1 A Date O r
0 [J3son Robmson TP Swansea 02/02/1950 04/05/18 __ {3 A Pete Deeurming- 1y
1 |Lionel Ritchie HMP Bristol 08/12/1 1
2 |Lorna Williamson HMP Holloway 10/04/1§ 4. Click on Duplicate @ Duplicate Values... 1
3 |Serena Williams HMP Holloway 31/01/1 Val 1
4 |John Steinbeck HMP Pentonville 16/02/1 alues More Rules... 1
5 |John Steinbeck HMP Pentonville 16/02/1 e - 6 1
Duplicate Values ? it
Format cells that contain: 6. The Duplicate Values window will
— open giving you the opportunity to
T i 1 i N . . . .
values with | Light Red Fill with Dark Red Text highlight Duplicate or Unique values
and what colour you would like to
Cancel
11. Removing duplicates
AutoSave B9 £ Search Alice Linell AL [Ea] —
File Home Insert Page Layout Formulas Review View Help Table Design 12 Share 1 Com
[BiFrom Text/csv [® Recent Sources A N2 = B= Joiz)
[® From Web [B Existing Connections Efj D @ mj Zl v T‘ <} E =2 @ @ )
Get Refresh N Filter Textto 40 What-If Forecast = Outline
Data v EE From Table/Range Al [2 BAdvanced | Columg £ ¥ B | Analysis v Sheet ¥
Get & Transform Data Querie . Sort & Filter a Tools Forecast
. ; . 2. Click on the Data tab IS .
1 - Prison - Date of birth ‘ JEL) Delete duplicate rows from a sheet.
2 8 OTOT 2002 Bace
3 . 08/02/2012 Bass, guitar You can pick which columns should
, | 1. Click anywhere on the R Drums be checked for duplicate
5 : 05/05/2014 Drums information.
- | table toselectit e o s
7 S5 21/03/2003 Guitar 2
8 |Harper Lee HMP Bronzefield 07/09/1949 04/04/2009‘Guitar 1 2
9 Hone Heke HMP Pentonville 27/04/1983 09/09/2016:Guitar 1
0 Jason Robinson HMP Swansea 02/02/1950 04/05/1999, Guitar 2
1 Lionel Ritchie HMP Bristol 08/12/1968 27/04/2007 Guitar 1
2 Lorna Williamson HMP Holloway 10/04/1948 19/02/2004_Guitas 1
3 |Serena Williams HMP Holloway 31/01/1981 24/11/20f 1
4 John Steinbeck HMP Pentonville 16/02/1965 21/03/2 3. C|ICk on the Remove 1
5 John Steinbeck HMP Pentonville 16/02/1965 21/03/2! . 1
6 Enid Blyton HMP Bronzefield 18/05/1961 w7/08/19y Duplicates command 2
7 |Marcus Clarke HMP Bristol 16/02/1970 21/03/2 1
8 |David Beckham HMP Pentonville 19/06/1971 o0l button 1
9 Max Senski HMP Swansea 08/03/1980 09/09/20: 2
PO |Jane Goodall HMP Holloway 03/02/1951 D4/05/1999§F'|anc, drums 36 1
1 Jane Goodall HMP Holloway 03/02/1951 04/05/1999 Piano. drums 36 1

11



Remove Duplicates ? X

To delete duplicate values, select one or more columns that contain
duplicates.

§§ Select All 3= Unselect All My data has headers

Columns
Nam 4. Select the columns you want to remove duplicates from.

[ prison (If you select multiple columns, all columns must contain a
0 birth duplicate value for the de-duplication to happen. The whole row
0 Date of birt containing the duplicate values will be deleted.)

Age now

Date registered v
] 9 |

Microsoft Excel X
5. The number or duplicates

removed will be displayed in a
window. If you realise you made a
mistake, use the Undo button.

o 4 duplicate values found and removed; 47 unique values remain.

12. Colour scales

Colour scales give you automatic recolouring based on your range of values — with different options to suit
what you are looking to highlight (i.e. is a low number good and so indicated by green or is it of concern and
needs to be highlighted in red?)

File Hoﬂ Insert Page Layout Formulas Data Review View Help Acrobat 1 Comments
<X ) . AN === ners . Einsert ~ X g
lasEl - o h e ; : — : (ﬁ, - Car%na\ hv?:éf\dﬁ I?EF{ EDPIG'F © & Szoz Fﬁ AIP
- Bl 7 u~EH-[ava- SE= B | B-% % BN ratings| tble Sylesv | EFomats | € Fiorv Selectv | Data
Clipboard 1] Font ] Alignment F] Number ] Cells Editing Analysis Sensitivity
11 - Je Total attendance Highiight Cell Rules >
A B E D E FTE) toprottom mutes > H I J
1 Date MM Supervisor HMP Hollowa'HMP Bristol HMP Pentonv HMP | s Total attend
2 Jan-17 Amina Hussaln 8 7 6 [E:ﬂ Data Bars 4 19 57
3 Feb-17 Amina Hussain 7 8 5 il il 57
4 Mar-17 Amina Hussain 8 8 5 IE] olorScales ' : : _ : 58
5 Mar-17 Amina Hussain 8 8 5 =D 1con sets N : : : 4 58
6 Apr-17 Amina Hussain 7 9 n 62
7 | May-17 Aslf Kahn 9 10 10 (] New Rle. More Rules 64
8 Jun-17 Aslf Kahn 10 8 3 @ Clear Rules > 19 66
9 Jul-17 Aslf Kahn 8 8 2 I Manage Rules.. 20 51
10 Aug-17 Aslf Kahn 8 6 5 10 5 12 486
1 Sep-17 Aslf Kahn 6 7 2 9 4 13_
12 Oct-17 Aslf Kahn 7 8 4 8 3 16 46
13 Nov-17 Jon Potter 8 7 3 9 3 17 47
14 Dec-17 Jon Potter 7 il 12 14 2 8 64
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You can also select More rules and precisely set what you need in terms of formatting based on contents of

cells.

New Formatting Rule

Select a Rule Type:

? X

= Format all cells based on their values

= Format only cells that contain

= Format only top or bottom ranked values

= Format only values that are above or below average
= Format only unique or duplicate values

= Use a formula to determine which cells to format

Edit the Rule Description:

Format all cells based on their values:
Format Style: |§3—COI0r Scale ‘

Minimum Midpoint

Maximum

Type: ‘LowestValue ‘ |Percenti|e

‘ | Highest Value |

Value: ‘(Lowest value) |50

El |(Highest value)

Color: I | |

I - |

OK Cancel
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Splitting columns

Often there is a need to break down data to make it easier to work with. For example, if you want to sort

people in alphabetical order using their surname you will need to make sure their name is split into first
name & surname columns.

Tip: It’s a good idea to first create a column to the right of the column you wish to split, for the second part
of the column contents to move into.

Music Mentors data with notes - Excel

Table Toals Alice Linell [Eal

1. Click on the

Review View Help Design Q Tell me what you want to do

Data tab -
*g = jurces [ Queries & Connections | & [Z]A Y WA B “Ecroup -

= L 2l B B 3
[& From el X gopections A N ZE Ungroup

Get £ Refresh zl sort Filter = Textto _, @ What-If Forecast
Data - . . All~ I# Advance Columns =5 ~ ' Analysis ~  Sheet
2. Highlight the !

Queries & Connections Sort & Filter Data Tools Forecast Outline

column to split

B1 Text to Columns

split a single column of text into
multiple columns, M

3. Click on the Text

1 E -
2 1|Wolfgang Puck to COIumns y For example, you can separate a
3 2|Julie Walters HMP Bronzef command button ;.olumndolf full names |‘nt0 separate
~ first and last name columns,
4 3| Margaret Atwood|HMP Bronzef
5 4{Usain Bolt HMP Manchester B _ You can choose how to split it up:
6 5|Alain Prost HMP Manchester 26459 i fixed width or split at each comma,
7 6|Andre Agassi HMP Swansea 20924 U period, or other character.
8 7|Harper Lee HMP Bronzefield 20706 (
9 Convert Text to Columns Wizard - Step 1 of 3 |
10 The Text Wizard has determined that your data is Delimited. NS 4 The convert Text to
If this is carrect, choose Next, or choase the data type that best describes your data, . .
Original data type Columns wizard will open
Choose the file type that best describes your data:
@ Delimited - Characters such as commas of tabs separate each field. o
) Fixed width -F ligned in columns with spaces between each field.
Preview of selected data: \
a:e White ol
forzel pazsons a3 ..
[abue gusives 1 5. Select Delimited & then
E olin Cregan
ine Htet - H
: ; click on Next
Cancel [ Back | Mext > | Finish

(A Delimiter is a blank space, comma, or other character or symbol that indicates the beginning or end of
a character string, word, or data item)

Convert Text to Columns Wizard - Step 2 of 3 @
This screen lets you set the delimiters your data contains, You can see how your text is affected
in the preview below,
6. Select what delimiter to use to
semical Treat consecutive delimiters as one . .
ECO?H':;" separate the data into columns. In this
- Text gualifier: |” |7| ey e
V] Space  ee—— example the data to split is separated
L i — by a space )
Data preview l
é )
fate |fmite 7. The wizard displays how
Sorrel [Parsons . .
. e
bue  puiltes the text will be split
[Colin  [Cregan L 4
Hine Htet I~
4 3
cancel | [ <Back | [ Nea> | [ Finisn |
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Convert Text to Columns Wizard - Step 3 of 3 ?

e

8. Select the data format for each

column. General automatically

x
This screen lets you select each column and set the Data Format,
Column data format [E———
@general
‘General’ converts numeric values to numbers, date values
O Text to dates, and all remaining values to text.
O Date: | DMY v Advanced...
O Do not import column (skip)
Destination: | 5651 +
Data preview
~
v
Cancel < Back Mext =

converts the column to the most
appropriate format. You can
override that now or later after
the split

J
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